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Preface 
 

Information in this manual is subject to change without notice and 
does not represent a commitment on the part of Eaton’s Cutler-
Hammer, Inc. Permission is granted to duplicate this material 
without modification only for your use or the internal use of other 
members of your company or your agents to assist you in the use 
and servicing of products purchased from Eaton’s Cutler-Hammer. 
No permission is granted to modify this material or include this 
material in a compilation. 

RESTRICTED RIGHTS LEGEND 
Use, duplication, or disclosure by the Government is subject to 
restrictions set forth in paragraph (b)(3)(B) of the Rights in Technical 
Data and Computer Software clause of DAR 7-104.9(a). 
Contractor/Manufacturer is Eaton Corporation’s Cutler-Hammer 
Business Unit, 811 Green Crest Drive, Columbus, OH 43081. 

TRADEMARKS 
PanelMate is a federally registered trademark of Eaton Corporation. 
MS-DOS, Microsoft, and Windows are federally registered 
trademarks of Microsoft Corporation. Data Highway and Data 
Highway Plus are trademarks of Allen-Bradley. DeviceNet is a 
trademark of Open DeviceNet Vendor Association. Iomega is a 
trademark of Iomega Corporation. 

Commercial brand names (trademarks) of products of 
manufacturers or developers, other than Eaton Corporation or its 
affiliates, that appear in this manual may be registered or 
unregistered trademarks of those respective manufacturers or 
developers, which have expressed neither approval nor disapproval 
of Cutler-Hammer products and services. 

2003 Eaton Corporation. All rights reserved. 

Printed in the United States of America. 

P/N 01-00502-01 
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Support Services 

The goal of Eaton’s Cutler-Hammer business unit is to ensure your greatest possible 
satisfaction with the operation of our products. We are dedicated to providing fast, 
friendly and accurate assistance. That is why we offer you so many ways to get the 
support you need. Whether it's by phone, fax or email, you can access Eaton’s Cutler-
Hammer support information 24 hours a day, seven days a week. Our wide range of 
services are listed below. 
You should contact your local distributor for product pricing, availability, ordering, 
expediting and repairs. 

Website Address www.cutler-hammer.eaton.com 

Use the Cutler-Hammer website to find product information. You can also find 
information on local distributors or Cutler-Hammer sales offices. 

e-COM Support Center VOICE: 800-356-1243  (8AM-6PM EST) 
FAX: 800-752-8602 
AFTER-HOURS EMERGENCY: 
• 800-543-7038  (6PM-8AM EST) 

Call the e-COM Support Center if you need assistance with placing an order, stock 
availability or proof of shipment, expediting an existing order, emergency shipments, 
product price information, returns other than warranty returns, and information on local 
distributors or sales offices. 

e-TRC  
Technical Resource Center 
(support for OI, PLC & IPC) 

VOICE: 
• 800-809-2772, selection 5  (8AM-5PM EST) 
• 414-449-7100, selection 5  (8AM-5PM EST) 
FAX: 614-882-0417 
EMAIL: CHATechSupport@eaton.com 
AFTER-HOURS EMERGENCY (PLANT DOWN 
ONLY): 
• 800-809-2772, selection 5  (5PM-8AM EST) 
• 414-449-7100, selection 5  (5PM-8AM EST) 

If you are in the US or Canada, and have OI/PLC/IPC questions, you can take 
advantage of our toll-free line for technical assistance with hardware and software 
product selection, system design and installation, and system debugging and 
diagnostics. Technical support engineers are available for calls during regular business 
hours. 

European PanelMate Support 
Center 

VOICE: +41 1 806 64 44 (9AM-5PM CET) 
EMAIL: CHSupport@bfa.ch 

This center, located in Zurich, Switzerland, provides high-level quality support and 
product repair services for your PanelMate products. You will receive real-time technical 
and application support. 
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Information Fax-Back Service 
For Legacy Products 

VOICE: 614-899-5323 

Legacy Cutler-Hammer product information, specifications, technical notes and company 
news are available to you via fax through this direct document request service. Using a 
touch-tone phone, you can select any of the info faxes from our automated product 
literature and technical document library, enter a fax number and receive the information 
immediately. 

Repair and Upgrade Service 
(support for OI & IPC) 

VOICE: 
• 800-809-2772, selection 5, 4  (8AM-5PM EST) 
• 414-449-7100, selection 5, 4  (8AM-5PM EST) 
FAX: 614-882-3414 
EMAIL: RepairCHA@eaton.com 

If you have questions regarding the repair or upgrade of an OI/IPC, contact your local 
distributor. Additional support is also available from our well-equipped Repair and 
Upgrade Service department. 
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Chapter 1: Introduction 
 

In this chapter, you will learn about the PanelMate Document Viewer. 
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Document Viewer 
Document Viewer is an application kit that provides a “padded-cell” browser for viewing 
files and web pages from the PanelMate.  Document Viewer can be thought of as a 
secure user interface to Microsoft Internet Explorer, which is running in the background.  
The difference between its “padded-cell” user interface and the Internet Explorer user 
interface is that the operator can navigate to and view only those files and web pages 
that are allowed by the “Home Page” of Document Viewer. 

The home page is a user configured HTML file (.htm) that can be created with any web-
publishing tool such as Microsoft FrontPage or Macromedia DreamWeaver.  URLs and 
Hyperlinks are placed in the “Home Page” that allow the user to select that link online 
and view the document or web page within the Document Viewer window.  In addition to 
Internet Explorer, Adobe’s Acrobat Reader is also running behind the scenes so that the 
operator can view .pdf files from the PanelMate.  Since virtually any file type, including 
CAD drawings, Word documents, graphics, etc., can be saved in .pdf format there is no 
limit to the types of information that can be viewed from within Document Viewer.  And 
since the operator’s Internet/Intranet experience can be constrained to only those sites 
and files that are defined by the home page and subsequent links, operators can’t 
choose “Where do you want to go today ….”.  When the Document Viewer is combined 
with PanelMate ePro’s Protect Mode you don’t have to worry about Internet cookies, 
viruses, unwanted downloads, or registry changes affecting PanelMate’s operational 
integrity. 

In short, Document Viewer gives operators access to the networked information they 
need without requiring separate terminals or PCs on the plant floor, all provided in a 
safe, and secure network browser. 

The Document Viewer application kit comes preloaded and ready to run on the 
PanelMate ePro XE and X1 models. 
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Demonstration Document Viewer Home Page with All Icons Displayed 
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Chapter 2: Getting Started With The Document Viewer 
 

In this chapter, you will learn: 
• About files used with the Document Viewer 
• About the Document Viewer demo 
• About installing and uninstalling the Document Viewer 
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Files Used With Document Viewer 
There are several files that you must know about when using the Document Viewer. 

• Document Viewer.exe - Document Viewer runtime and configuration program.  If 
you execute the program with a .dcv file name as a command line argument then the 
Document Viewer program will execute in run mode using the named .dcv file for 
specifications.  If there is no file name appended when executing Document Viewer 
program then program will execute in configuration mode and is used to create 
and/or edit .dcv files. 

• filename.dcv –Document Viewer runtime attribute file.  It describes the attributes for 
the Document Viewer and it contains the URL address / filename list and home page 
reference.  The .dcv file is created by running the Document Viewer in configuration 
mode (with no file name as a command line argument). 

• filename.txt, filename.pdf, filename.jpg, filename.htm –files that can be viewed 
“displayed” by the Document Viewer when in run mode.  The filename is the name 
you assign to the files. 

Document Viewer Demo 
A demo of the Document Viewer is preloaded on the PanelMate ePro XE and X1 
models.  This demo will automatically run when you power up the PanelMate ePro XE or 
X1.  Once the demo is launched you can demonstrate the Document Viewer by selecting 
the Document Viewer button from the PanelMate ePro XE or X1 menu page (explore 
and have some fun).   

If you want to see how the Document Viewer was configured you can review the 
XEdemo.pps or DVdemo.pps and demo.dcv files in more detail using the configuration 
software.  The demo files are provided on the PanelMate Power Pro software CD (V2.21 
and above).  The demo files can be found under PM\Demos\ePro XE or 
PM\Demos\ePRo X1.  The demo configurations demonstrate the Document Viewer in 
addition to the three other application kits: Headline Manager, Recipe Manager and 
Trend Viewer (XE models only).  The demo files are as follows: 

File Name PanelMate ePro 
XE/X1 File Path 

File Description 

PMStart.cmd D:\ Startup command file 

XEdemo.pps or 
DVdemo.pps or 
HMdemo.pps or 
RMdemo.pps 

D:\Cfg\ PanelMate configurations 

XEdemo.ois or  
RMdemo.ois 

D:\Cfg\ Recipe programs 

recipelist.csv D:\Cfg\ Recipe list 

demo.dcv D:\Document Viewer\ Document Viewer configuration 
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demo_home.htm D:\Document Viewer\ Document Viewer home page 

demobot.hlm D:\Headline Manager\ Headline configuration (bottom) 

demohl.csv  D:\Headline Manager\ Headline messages 

demomid.hlm D:\Headline Manager\ Headline configuration (middle) 

demotop.hlm D:\Headline Manager\ Headline configuration (top) 

demo_xxx.csv D:\Recipe Manager\ Recipe files (ingredients) 

demoRamps.cht D:\Trend Viewer\ Trend Viewer chart configuration 
(ramp) 

demoRandom.cht D:\Trend Viewer\ Trend Viewer chart configuration 
(random) 

demoSinewave.cht D:\Trend Viewer\ Trend Viewer chart configuration 
(sine) 

These appropriate files are preloaded onto the PanelMate ePro XE and X1 models into 
the directories listed above.  The demo can be started by selecting Start>Run PMStart 
or rebooting the system. 

The demo .pps file uses an OPC server (simulation driver) to simulate reading data from 
a PLC for the Trend Viewer and demo pages. 

Downloading Document Viewer Files 
If you are configuring the Document Viewer .dcv files on a computer different from the 
online unit you must copy the Document Viewer files to the application area on the target 
unit.  You will need to copy all .dcv files to the target unit. 

Note:  When using a PanelMate ePro XE or X1 models, it is recommended that you copy 
the user-created .dcv files and documents (.jpg, .txt, .htm, .pdf) to the D:\Document 
Viewer\ directory.  The D:\ partition is designated as the user area and can be written to 
when the unit is in Protect Mode. 

Installing Document Viewer Software 
On the PanelMate ePro XE and X1 models the current Document Viewer software will 
be pre-installed.  If you want to upgrade your Document Viewer to a newer version then 
you will need to install the Document Viewer software from the PanelMate Power Pro 
software CD (V2.1 and higher).  Note that PanelMate ePro XE or X1 models have 
expanded storage and memory areas to support the Document Viewer and other 
application kits.  The Document Viewer is not supported by the base PanelMate ePro 
models. 

Once you have prepared the target unit for software downloads and have initiated the 
installation process, you will need to select the following items from the installation 
program in the sequence listed. 

• Install Software 

• Install PanelMate Kits 
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• Install Application Kits 

If it is a first install then you can choose between Full, Compact or Custom installation.  
Selecting the Full option will result in all application kits being installed.  If you select 
Custom then you can select the combination of kits that you want installed. 

If the application kit software has already been installed you can choose between 
Modify, Repair and Remove.  Modify will let you select the files you want to install and 
uninstall.  Repair will replace the files already installed and Remove will uninstall all of 
the installed files. 

The Document Viewer files are installed (default location) in a folder called: 
C:\Program Files\Cutler-Hammer\PanelMate Application Kits\ 

Selecting the Document Viewer on PanelMate ePro X1 Units 
PanelMate ePro X1 models are designed to run one of three application kits.  The 
Document Viewer application kit is the default selected kit.  If you have activated a 
different application kit you will have to re-activate the Document Viewer Kit by using the 
Application Kit Selection Utility.  To select the Document Viewer Kit on your PanelMate 
ePro select Start>Programs>ePro Tools>Kit Selection.  Select the Document Viewer 
radio button and then OK to complete the selection. 

 

Uninstalling Document Viewer Software 
If you are not going to use the Document Viewer software, you can uninstall the 
software. 

On a PanelMate ePro select the following: 

Start>Programs>PanelMate Software>Uninstall PanelMate Application Kits 

On a PC use the Add/Remove Programs feature to remove the program.  Select 
PanelMate Application Kits to launch the installation wizard. 

In both cases, you will be presented with the choice of Modify, Repair and Remove.  
Select Modify and then uncheck the files you want removed or select Remove to remove 
all of the application kit files. 



14     PanelMate Document Viewer Users Guide  

 

Chapter 3: Using the Document Viewer in 
Configuration Mode 

 

In this chapter, you will learn: 
• How to create Document Viewer files 
• How to use the sample file to help you build configurations 
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Configuring Document Viewer Run Mode Attributes (.dcv 
Files) 

To configure Document Viewer attributes you need to run the Document Viewer program 
in configuration mode.  You can run Documents Viewer on your PanelMate ePro or on a 
PC.  When you save the document viewer attributes you will be saving the information in 
a .dcv file. 

Run the Document Viewer using the following sequence: 
Start>Programs>PanelMate Software>Document Viewer>Document Viewer Config 

Once you have started the Document Viewer program in the configuration mode you will 
see the following window with default values assigned to all fields. 
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If you would like to edit an existing .dcv file then select File>Open and select the 
desired .dcv file.  When you are done with the configuration process then select 
File>Save or File>Save As to save the new .dcv file. 

Each field is described in detail below. 

Check boxes are used to select what icons will appear in the Document Viewer run 
mode window.  Customization is important so that operators are only given the tools that 
are needed 

  Forward/Back Buttons check box – select this item if you want to have the 
Forward and Back arrows appear on the Document Viewer window.  These keys will 
allow the operator to move backward and forward through the list of viewed items. 

                             Browser Address Bar check box – select this item if you want 
to have the Browser Address Bar and Go button appear on the Document Viewer 
window.  This will allow operators to select URL addresses and filenames from the drop 
down menu.  The items in the drop down menu will be from the URL Address / 
Filename List. 

 Home Page Button check box – select this item if you want to have the Home 
button appear on the Document Viewer window.  This will allow operators to quickly 
return to the home display. 

 Open File Button check box – select this item if you want to have the Open File 
button appear on the Document Viewer window.  This will allow operators to open a file.  
Files allowed are .htm, .jpg, .pdf and .txt types. 

 Refresh Button check box – select this item you want to have the Refresh button 
appear on the Document Viewer window.  This button will allow operators to recall the 
last URL address or file name requested. 

 Browser Stop Button check box – select this item if you want to have the 
Browser Stop button appear on the Document Viewer window.  This button will stop the 
document viewer from drawing the currently requested URL address or file. 

 Minimize Button check box – select this item if you want to have the Minimize 
button appear on the Document Viewer window.  This button will allow the operator to 
minimize the document viewer while in run mode.  After the Document Viewer window 
has been minimized, a button will appear at the top right of the display with the title 
"Document Viewer".  Select this button to Maximize the Document Viewer window. 

 Hide Button check box – select this item if you want to have the Hide button 
appear on the Document Viewer window.  This button will allow the operator to remove 
the Document Viewer window from the screen.  This is different from Minimize in that the 
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only way to recall the window is to trigger the DDE Link Setting Item.  No recall button 
will automatically be displayed 

 Exit Button check box – select this item if you want to have the Exit button appear 
on the Document Viewer window.  This item will terminate the execution of the document 
viewer.  Note that the Document Viewer program will terminate when the specified DDE 
link is broken.  This means that when the PanelMate PC Pro runtime program ends then 
the Document Viewer program will end.  Use of this icon is recommended for testing 
purposes only and is not needed for run mode. 

Home Page – enter the URL address or file name of the home page.  This page will be 
displayed when opening the Document Viewer window for the first time or when pressing 
the Home button.  The home page is typically a .htm file that can be easily created using 
tools such as Microsoft FrontPage or Macromedia DreamWeaver. 

URL Address / Filename List – enter the URL addresses and names of files that can 
be viewed using the Document Viewer.  These items will appear in the Browser Address 
Bar drop down menu.  It is recommended that URL addresses are local intranet sites as 
the Document Viewer running on PanelMate ePro will not support many of the features 
and support programs required to view many Internet sites.  Files supported are .htm, 
jpg, .pdf, and .txt types. 

If there are a large number of files that will be accessed by the operator it is 
recommended that you create files that include hyperlinks using HTML editing tools such 
as Microsoft FrontPage or Macromedia DreamWeaver.  If you do not do this, the 
operator will be forced to use a drop down menu that has too many entries or the 
operator will have to browse for files using the File Open feature.  Using hyperlinks 
make it very easy to organize files for operators. 

DDE Link Settings 

Note:  The PanelMate PC Pro runtime software (pmc.exe) has a built in DDE server.  
When the PanelMate PC Pro runtime program terminates the Document Viewer will 
automatically terminate. 

Topic – DDE topic for the Item.  The format is applicationname|topic where 
applicationname is the name of the program providing the data.  When using 
PanelMate ePro or PC Pro the applicationname is PMC. The topic is typically a 
scratchpad variable so it is defined as “sp”.  An example for this field is PMC|sp.  The 
applicationname and topic are separated by the “|” character.  Note that this is the bar 
or pipe character and not a lower case letter L ( l ). 

Item – scratchpad tagname for the trigger value.  When the trigger value changes to 1 
the Document Viewer window will be displayed in the maximized view when in run 
mode.  The trigger value is typically changed by including it in PanelMate variable-sized 
control button defined as Normally Closed Momentary on a page or multiple pages.  
When pressed, the button will clear the trigger value (0) and then set the trigger value (1) 
causing the Document Viewer window to be displayed. 
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Previewing the Document Viewer Runtime Window 
In order to test the Document Viewer window as it will appear in run mode select 
File>Run.  When done testing select the Exit button (if there is one) or terminate the 
program using a task manager. 

Configuring PanelMate Applications for the Document Viewer 
(.pps Files) 

In order to switch between the PanelMate application and the Document Viewer running 
in the background you must add a variable-sized pushbutton to each page from which 
you wish to call the Document Viewer.  The Variable-Sized Control Button should be set 
to Normally-Closed, Momentary and the Reference should match the DDE Link Setting 
Item configured in the Document Viewer configuration.  The normally closed momentary 
setting results in setting the reference to a value of 0 when pressed and 1 when 
released.  This allows the switch to the Document Viewer window to take place upon the 
release of the pushbutton so that the button state will be in the normal state when the 
PanelMate window is displayed after hiding or minimizing the Document Viewer window.  
As an example, if the DDE Link Setting Topic is set to: PMC|sp, and the Item is set to 
docview then the following dialog settings for the control button would be correct: 

PanelMate Configuration for Variable-Sized Control Button For Document Viewer 

 

Using the Sample Files 
A sample pps file can be found on the PanelMate Power Pro software CD (V2.1 and 
higher) under PM\Kits\Sample to help you build your PanelMate configuration that will 
be using the Document Viewer.  The sample.pps file contains a page 197 that contains 
variable-sized buttons (defined as Normally Closed Momentary) that can be used to set 
the DDE link trigger to call up the Document Viewer program.  You can simply copy the 
desired variable-sized buttons to your application.  The sample.pps button for 
Document Viewer changes the value of the scratchpad variable docview to 0 and then 



Chapter  3:  Using the Document Viewer in Configurat ion Mode     19 

 

to 1.  If necessary you can change the scratchpad variable name used in the button and 
assigned during the configuration mode in the .dcv file. 

 

 
Control Buttons - Sample Configuration Page 197 
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Chapter 4: Using the Document Viewer in Run Mode 
 

In this chapter, you will learn: 
• How to launch the Document Viewer 
• How to use the Document Viewer in run mode 
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Document Viewer Launching Methods 
The Document Viewer is designed to run in tandem with the PanelMate PC Pro 
application. 
There are two recommended ways to launch the Document Viewer with a PanelMate PC 
Pro configuration: 

1)  Using the startup PMStart.cmd file at boot-up 
2)  Using Start>Run PMStart 

Notes: 
• During boot-up, there will be no messages displayed telling you that the Document 

Viewer is launching. 
• The Document Viewer must be selected as the active kit when using X1 models.  

See Chapter 2 - Selecting the Document Viewer on PanelMate ePro X1 Units for 
details. 

Using the Startup PMStart.cmd File to Automatically Launch a 
Configuration and Document Viewer 

When your run time unit boots up, it automatically launches the PMStart.cmd file.  If you 
would like the run time unit to automatically launch your configuration and Document 
Viewer, you can do so by editing the PMStart.cmd file using Notepad.  To do this, 
complete the following steps. 
Note:  When using a PanelMate ePro, the PMStart.cmd file is found in the root directory 
of the D:\ partition.  There are two PMStart.cmd files described in this manual, one for 
the XE models and one for the X1 models. See Appendix A for a complete listing of the 
PMStart.cmd files. 
 
1) Connect a PS/2 mouse and keyboard to your unit. 
2) Reboot your unit. 
3) Click Start>Explorer. 
4) Browse to find PMStart.cmd and then right-click the file and click Edit. 

Result: Notepad is launched. 
5) Edit the following line in the PMStart.cmd file by replacing the .pps file name with 

the name of your ePro configuration. 
set MY_CFG=d:\cfg\xxx.pps 

6) In the PMStart.cmd file you will see a line with the following: 
set MY_DCVFile="d:\Document Viewer\demo.dcv" 

Replace the demo.dcv file name with the name of your Document Viewer 
configuration file.  If you are not using the Document Viewer then replace the file 
name with "none".  If you store the configuration file at a path location different from 
the default location make sure that you enter the correct path name. 

7) Save the edited PMStart.cmd file, then close Notepad. 
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By-Passing the Document Viewer in the PMStart.cmd File 
If you do not want to launch the Document Viewer then make sure that the file name for 
the line noted in step 6 above is set to "none" as shown here. 

Set MY_DCVFile="d:\Document Viewer\none.dcv" 

Power-Up Sequence 
Once power is connected to your PanelMate ePro run time unit, the following occurs: 
1) A DOS prompt appears on the screen, informing you that the unit is initializing 

system resources. 
2) The Windows NT Embedded operating system boots up. 
3) A Delay-Connecting to Touchscreen Controller window appears, informing you 

that the unit is loading the touchscreen driver. 
4) The PanelMate PC Pro application launches. 
5) The Document Viewer program launches 
6) Other application kits launch as specified in the PMStart.cmd file 
Note:  You may the see the error “DDE Link not available” when attempting to initialize 
the Document Viewer window.  If you receive this error it could mean that the DDE 
server is not established.  You can increase the sleep time by modifying the following 
line in the PMStart.cmd file to a time longer than 40 seconds. 

Set CFG_LOAD_TIME=40 
The error could also be the result of the DDE Topic/Item configured in the .dcv file not 
being found.  If PanelMate PC Pro is specified (PMC) then make sure the Topic and 
Item values are included in the PanelMate configuration file (typically in a variable-sized 
control button). 

Document Viewer in Run Mode 
The intent of the Document Viewer is to provide a controlled environment for operators 
that need to view web pages and documents.  The web pages being viewed are typically 
Intranet sites and customized HTML pages .  Files supported are .htm, .jpg, .pdf and 
.txt file types.  Document Viewer on PanelMate ePro can easily prevent operators from 
uncontrolled web surfing and file downloading from Internet sites. 

Keep in mind that the Document Viewer on PanelMate ePro may not support many of 
the features and functions required by Internet sites so it is recommended that URL 
addresses are for local, known intranet web sites only.  It is also recommended that 
customized HTML pages be created that present hyperlinks to the files needed.  Using 
this technique, operators can be presented with only the options that are applicable to 
the operation of the machine or process. 

The operator can perform a variety of operations depending on the icons selected.  The 
icons that are presented were selected while in the configuration mode.  The Document 
Viewer window attributes are stored in a .dcv file and are provided as a command line 
argument when running the Document Viewer.  The Document Viewer window is 
displayed whenever the DDE Link Settings Item value specified in the .dcv files 
changes to 1. 



Chapter  4:  Using the Document Viewer in Run Mode     23 

 

Run mode icons are as follows: 

  Forward/Back Buttons - move backward and forward through the list of 
viewed items. 

                             Browser Address Bar - select URL addresses and filenames 
from the drop down menu and then select the Go button.  The items in the drop down 
menu are from the URL Address / Filename List assigned during configuration mode. 

 Home Page Button  - return to the assigned home display. 

 Open File Button - open a file.  Supported file types include .htm, .jpg, .pdf and 
.txt formats. 

 Refresh Button - recall the last URL address or file name requested. 

 Browser Stop Button - stop the document viewer from drawing the currently 
requested URL address or file. 

 Minimize Button - minimize the Document Viewer window.  The window will be 
removed and a small button will appear at the top of the display labeled "Document 
Viewer".  Select this button to maximize the Document Viewer window 

 Hide Button – hide the Document Viewer window.  The Document Viewer window 
will need to be recalled by using the DDE Link Setting Item trigger. 

 Exit Button - terminate the execution of the Document Viewer program.  Note that 
the Document Viewer will automatically terminate when the PanelMate PC Pro runtime 
program is terminated (ie. The DDE link is broken). 

Document Viewer  - maximize the Document Viewer window.  This button will appear 
at the top right after selecting the Minimize button. 
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Chapter 5: Troubleshooting 
 

In this chapter, you will learn how to troubleshoot the Document Viewer. 
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Document Viewer Troubleshooting 
Issue Possible Cause Corrective Action 

DDE Link not 
available 
Topic: xxx|xxx 
Item: xxx 

Startup sleep time not long 
enough so the DDE Topic is not 
available when the Trend 
Viewer is trying to make 
connections or the DDE Topic 
or Item does not exist 

Make the sleep time longer in 
the PMSTart.cmd file or check 
to make sure the configured 
DDE Topic and Item are valid 
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Appendix A: Directories and Files 
 

In this appendix, you will learn: 
• About the PanelMate ePro directory and file layout 
• About the PMStart.cmd file 
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PanelMate ePro XE Treeview 
The following lists the treeview of the PanelMate ePro XE units with the demo files loaded.  A 
similar organization should be used for your application.  You can write to the D:\ partition when 
the ePro is in Protect Mode. 

D: 
 PMStart.cmd demo start-up command file (see descriptions in the next section) 

 Cfg (put the .pps, .ois and recipelist.csv files here) 
  XEdemo.pps demo configuration 
  XEdemo.ois demo recipe script engine 
  recipelist.csv demo list of recipe names 
  recipemanager.log log file for the Recipe Manager 
  simdemo.opf OPC server configuration (OPC server & simulation driver) 
  chddesrv.exe demo DDE server (used for data simulation) 

 Document Viewer (put the .dcv and data files here) 
  demo.dcv demo URL/Filename list 
  demo_home.htm demo startup page for Document Viewer 
  relnotes.txt demo .txt file to call up 
  ePro-8 cutout template.pdf demo .pdf file to call up 
  1219B power supply.jpg demo .jpg file to call up 
  ePro.jpg demo .jpg file to call up 
  PM help.htm demo .htm file to call up 
  *.gif files files for *.htm files 

 Headline Manager (put the .hlm and headline .csv files here) 
  demobot.hlm demo headline specs – bottom 
  demohl.csv demo Headline Manager messages 
  demomid.hlm demo headline specs – middle 
  demotop.hlm demo headline specs – top 

 Recipe Manager (put the recipe file .csv files here) 
  demo_xxx.csv demo Recipe ingredients – 20 files where xxx is the recipe name 

 Trend Viewer (put the .cht files here) 
  demoRamps.cht demo chart with ramp data 
  demoRandom.cht demo chart with random data 
  demoSinewave.cht demo chart with sine data 
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PanelMate ePro X1 Treeview 
The following lists the treeview of the PanelMate ePro X1 units with the demo files loaded.  A 
similar organization should be used for your application.  You can write to the D:\ partition when 
the ePro is in Protect Mode. 

D: 
 PMStart.cmd demo start-up command file (see descriptions in the next section) 

 Cfg (put the .pps, .ois and recipelist.csv files here) 
  DVdemo.pps Document Viewer demo configuration 
  HMdemo.pps Headline Manager demo configuration 
  RMdemo.pps Recipe Manager demo configuration 
  RMdemo.ois recipe script engine 
  recipelist.csv demo list of recipe names 
  recipemanager.log log file for the Recipe Manager 
  simdemo.opf OPC server configuration (OPC server & simulation driver) 
  chddesrv.exe demo DDE server (used for data simulation) 

 Document Viewer (put the .dcv and data files here) 
  demo.dcv demo URL/Filename list 
  demo_home.htm demo startup page for Document Viewer 
  relnotes.txt demo .txt file to call up 
  ePro-8 cutout template.pdf demo .pdf file to call up 
  1219B power supply.jpg demo .jpg file to call up 
  ePro.jpg demo .jpg file to call up 
  PM help.htm demo .htm file to call up 
  *.gif files files for *.htm files 

 Headline Manager (put the .hlm and headline .csv files here) 
  demobot.hlm demo headline specs – bottom 
  demohl.csv demo Headline Manager messages 
  demomid.hlm demo headline specs – middle 
  demotop.hlm demo headline specs – top 

 Recipe Manager (put the recipe file .csv files here) 
  demo_xxx.csv demo Recipe ingredients – 20 files where xxx is the recipe name 
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PanelMate ePro XE PMStart.cmd File 
This is the PMStart.cmd file that is preloaded on the PanelMate ePro XE unit in its 
default state.  Lines will be edited for your application.  See Chapter 4: Recipe Manager 
Launching Methods for more details.  This file can be found on the PanelMate Power 
Pro CD (V2.21 and higher) in PM\Demos\ePro XE 

@echo off 
REM * To set this batch file to automatically start a 
REM * PanelMate PC Pro Application, set the variable 
REM * MY_CFG to the desired path\filename. 
 
set MY_CFG=d:\cfg\XEdemo.pps 
 
REM * If you are going to start Document Viewer, 
REM * Headline Manager, or Trend Viewer after the 
REM * PanelMate configuration loads, set the variable 
REM * CFG_LOAD_TIME to the number of seconds it takes 
REM * to completely boot up the PPS file. Measured from 
REM * when begins to load until the first display is drawn 
REM * following a power down reboot. 
 
set CFG_LOAD_TIME=40 
 
REM * To set this batch file to automatically start 
REM * Document Viewer, set the variable MY_DCVFile 
REM * to the desired path\filename of your Document 
REM * Viewer Configuration file (.DCV) 
REM * To by-pass the Document Viewer use the file name none.dcv 
 
set MY_DCVFile="d:\Document Viewer\demo.dcv" 
 
REM * To set this batch file to automatically start 
REM * up to three Headlines, set the variables 
REM * MY_TOPHL, MY_MIDHL, and MY_BOT to the desired 
REM * path\filename of the three Headline Manager 
REM * Configuration files (.HLM) 
REM * To by-pass a headline use the file name none.hlm 
 
set MY_TOPHL="d:\Headline Manager\demotop.hlm" 
set MY_MIDHL="d:\Headline Manager\demomid.hlm" 
set MY_BOTHL="d:\Headline Manager\demobot.hlm" 
set MY_PTRHL="d:\Headline Manager\none.hlm" 
 
REM * To automatically start Recipe Manager you do 
REM * not need to do anything within this batch file. 
REM * Just place the file recipelist.csv in the same 
REM * directory as the PanelMate PC Pro application 
REM * file (.PPS) and copy the RecipeManager.OIS file to the 
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REM * same directory and rename the .OIS file to match 
REM * the name of the .PPS file (Example: Myconfig.OIS) 
 
REM * To automatically start Trend Viewer, leave the 
REM * variable START_TREND set to YES. If you do not want 
REM * Trend Viewer to start, change to variable to NO 
 
set START_TREND="YES" 
 
if exist %MY_CFG% goto START_APP 
goto NO_APP 
 
:START_APP 
echo    Starting PanelMate Application %MY_CFG%... 
d: 
cd d:\cfg 
start c:\pmconfig\ntonline\pmc.exe %MY_CFG% 
sleep %CFG_LOAD_TIME% 
 
if exist %MY_DCVFile% goto START_DCV 
goto NO_DCV 
 
:START_DCV 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Document Viewer.lnk" 
%MY_DCVFile% 
sleep 2 
 
:NO_DCV 
if exist %MY_TOPHL% goto START_TOP 
goto NO_TOP 
 
:START_TOP 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_TOPHL% 
sleep 2 
 
:NO_TOP 
if exist %MY_MIDHL% goto START_MID 
goto NO_MID 
 
:START_MID 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_MIDHL% 
sleep 2 
 
:NO_MID 
if exist %MY_BOTHL% goto START_BOT 
goto NO_BOT 
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:START_BOT 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_BOTHL% 
sleep 2 
 
:NO_BOT 
if exist %MY_PTRHL% goto START_PTR 
goto NO_PTR 
 
:START_PTR 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_PTRHL% 
sleep 2 
 
:NO_PTR 
if %START_TREND% == "YES" goto START_TREND 
goto EXIT 
 
:START_TREND 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Trend Viewer.lnk" 
goto EXIT 
 
:NO_APP 
echo    PanelMate Application %MY_CFG% Not Found... 
sleep 5 
 
:EXIT 
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PanelMate ePro X1 PMStart.cmd File 
This is the PMStart.cmd file that is preloaded on the PanelMate ePro X1 unit in its 
default state to demonstrate the Document Viewer. 

Lines will be edited for your application.  See Chapter 4: Document Viewer Launching 
Methods for more details.  This file can be found on the PanelMate Power Pro CD 
(V2.21 and higher) in PM\Demos\ePro X1. 

You will also need to make sure that the Document Viewer is the selected kit.  See 
Chapter 2: Selecting the Document Viewer on PanelMate ePro X1 Units for details. 

@echo off 
REM * To set this batch file to automatically start a 
REM * PanelMate PC Pro Application, set the variable 
REM * MY_CFG to the desired path\filename. 
 
set MY_CFG=d:\cfg\DVdemo.pps 
 
REM * If you are going to start Document Viewer, 
REM * Headline Manager, or Trend Viewer after the 
REM * PanelMate configuration loads, set the variable 
REM * CFG_LOAD_TIME to the number of seconds it takes 
REM * to completely boot up the PPS file. Measured from 
REM * when begins to load until the first display is drawn 
REM * following a power down reboot. 
 
set CFG_LOAD_TIME=40 
 
REM * To set this batch file to automatically start 
REM * Document Viewer, set the variable MY_DCVFile 
REM * to the desired path\filename of your Document 
REM * Viewer Configuration file (.DCV) 
REM * To by-pass the Document Viewer use the file name none.dcv 
 
set MY_DCVFile="d:\Document Viewer\demo.dcv" 
 
REM * To set this batch file to automatically start 
REM * up to three Headlines, set the variables 
REM * MY_TOPHL, MY_MIDHL, and MY_BOT to the desired 
REM * path\filename of the three Headline Manager 
REM * Configuration files (.HLM) 
REM * To by-pass a headline use the file name none.hlm 
 
set MY_TOPHL="d:\Headline Manager\none.hlm" 
set MY_MIDHL="d:\Headline Manager\none.hlm" 
set MY_BOTHL="d:\Headline Manager\none.hlm" 
set MY_PTRHL="d:\Headline Manager\none.hlm" 
 
REM * To automatically start Recipe Manager you do 
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REM * not need to do anything within this batch file. 
REM * Just place the file recipelist.csv in the same 
REM * directory as the PanelMate PC Pro application 
REM * file (.PPS) and copy the RecipeManager.OIS file to the 
REM * same directory and rename the .OIS file to match 
REM * the name of the .PPS file (Example: Myconfig.OIS) 
 
if exist %MY_CFG% goto START_APP 
goto NO_APP 
 
:START_APP 
echo    Starting PanelMate Application %MY_CFG%... 
d: 
cd d:\cfg 
start c:\pmconfig\ntonline\pmc.exe %MY_CFG% 
sleep %CFG_LOAD_TIME% 
 
if exist %MY_DCVFile% goto START_DCV 
goto NO_DCV 
 
:START_DCV 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Document Viewer.lnk" 
%MY_DCVFile% 
sleep 2 
 
:NO_DCV 
if exist %MY_TOPHL% goto START_TOP 
goto NO_TOP 
 
:START_TOP 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_TOPHL% 
sleep 2 
 
:NO_TOP 
if exist %MY_MIDHL% goto START_MID 
goto NO_MID 
 
:START_MID 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_MIDHL% 
sleep 2 
 
:NO_MID 
if exist %MY_BOTHL% goto START_BOT 
goto NO_BOT 
 
:START_BOT 
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"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_BOTHL% 
sleep 2 
 
:NO_BOT 
if exist %MY_PTRHL% goto START_PTR 
goto NO_PTR 
 
:START_PTR 
"C:\PROGRAM FILES\Cutler-Hammer\PanelMate Application Kits\Headline 
Manager.lnk" %MY_PTRHL% 
sleep 2 
 
:NO_PTR 
goto EXIT 
 
:NO_APP 
echo    PanelMate Application %MY_CFG% Not Found... 
sleep 5 
 
:EXIT 
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